# Contents

**EXPORT** ................................................................................................................................. 1

**Accessing Export Records** ........................................................................................................... 2
  Finding and Opening Export Records .............................................................................................. 3
**Parts of an Export Record** ............................................................................................................. 4
  Filters Tab ......................................................................................................................................... 4
  Output Tab ......................................................................................................................................... 5
**Export Types** ................................................................................................................................. 7
**Export Formats** ............................................................................................................................... 8
  Additional Fields and Options For Export Formats ............................................................................... 9
**Export Styles** .................................................................................................................................. 9
  Flat Style Exports .............................................................................................................................. 10
  Relational Style Exports ..................................................................................................................... 12
**Understanding Export Output Fields** ............................................................................................ 15
  Using Criteria Groups ....................................................................................................................... 15
  Output Criteria Screens ..................................................................................................................... 19
**Creating an Export** ......................................................................................................................... 20
**Running an Export from the Export Page** ....................................................................................... 27
**Using the Word Merge Process in Export** ....................................................................................... 28
  Creating a Simple Word Merge ......................................................................................................... 29
  Creating a Conditional Word Merge .................................................................................................. 38
**INDEX** ............................................................................................................................................. 53
Export

Accessing Export Records ................................................................. 2
Finding and Opening Export Records ................................................. 3
Parts of an Export Record ................................................................. 4
Filters Tab ......................................................................................... 4
Output Tab ......................................................................................... 5
Export Types ....................................................................................... 7
Export Formats .................................................................................... 8
Additional Fields and Options For Export Formats ................................. 9
Export Styles ....................................................................................... 9
Flat Style Exports ................................................................................ 10
Relational Style Exports ................................................................. 12
Understanding Export Output Fields ................................................. 15
Using Criteria Groups ....................................................................... 15
Output Criteria Screens ..................................................................... 19
Creating an Export ............................................................................ 20
Running an Export from the Export Page ........................................... 27
Using the Word Merge Process in Export ......................................... 28
Creating a Simple Word Merge ....................................................... 29
Creating a Conditional Word Merge .................................................. 38
Exporting is the process used to extract selected information from your Education Edge database to use, update, or view in another software application. For example, you can export data to use in a word processing program for mailings, a spreadsheet program for further analysis, or Crystal Reports for custom report design.

The export process consists of identifying information to extract from your database, determining the file format for the information, and transferring the information to a specified location. While the processes and capabilities of Query and Export overlap, Export is a more advanced data extraction and reporting tool. It can better organize one-to-many relationships and other complicated types of data into simpler formats. For more information about queries, see the Query Guide for Education Edge.

The security settings you establish in Administration apply to Export. For example, if you prohibit admissions assistants from viewing faculty records, they cannot export faculty information in Export. If you deny a group access to all Export options, Export does not appear on the navigation bar for those users.

### Accessing Export Records

**Tip:** You can add Export favorites to the navigation bar, home page, or Favorites menu. For more information about using favorites, see the Program Basics Guide.

The Export page contains the commands necessary to complete all exporting functions. From this page, you can find, add, open, delete, and run exports.

To access the Export page, select Export from the navigation bar. The Export page appears.
Finding and Opening Export Records

To open export records from the Export page, in the grid, double-click an export, or select one and click Open.

There are several tools you can use to locate saved export records. You can use the Type and Format fields to filter the grid by export type or export format, or mark Only show my exports to display only the exports you created. You can also search for saved exports using the Find button on the action bar.

- Locating and opening an export record using the Find button
  1. From the navigation bar, select Export. The Export page appears.

  2. Click Find. The Find screen appears.

  3. In the Field field, select a search category such as “Name” or “Export type”.

  4. In the Find what field, enter specific field information you want to find. For example, if you selected “Name” in the Field field, you can enter the first three letters of the name to narrow the search.

  5. In the Match field, select the part of the field to search.

  6. To find only records with identical upper and lower case characters, mark Match case.
7. When you have entered your search criteria, click **Find First** or **Find Next**. The program selects the first or next record matching your criteria.

8. Once you locate the export, select it and click **Open**. The selected export record appears.

9. On the export record, you can view information or make changes.

10. To save the export record and return to the Export page, click **Save and Close**.

### Parts of an Export Record

You create an export by setting parameters in the export record. The export record consists of two tabs, the Filters and Output tabs, where you identify specific output fields and criteria and select which records to export.

#### Filters Tab

**Note:** If you want to include all records in the export, you do not need to use the Filters tab. For new exports, all records are included by default.
On the Filters tab, you select criteria that determines which records to include in an export. For example, to create a student export that includes only enrolled students, on the Filters tab, choose Selected in the Include column for **Student Current Statuses**. The Selected Student Current Statuses screen appears on which you select the Enrolled status. By selecting the Enrolled status, all other student statuses are “filtered out”, and only enrolled students are included in the export. For more information about filtering criteria, see the Program Basics chapter of the *Program Basics Guide*.

### Output Tab

On the Output tab, you select fields from a tree view that correspond with data you want to include in the export. The Output tab consists of the **Available Fields** box and the **Output** box. You can resize the two boxes, and you can drag and drop fields back and forth between the two boxes.

**Glossary:** A criteria group in *Export* is a set of related fields from the same record type. For more information about criteria groups, see “Using Criteria Groups” on page 15.

The **Available Fields** box contains a tree view of all criteria groups available for the export type you selected. You can narrow the fields listed in the **Available Fields** box by selecting a specific criteria group in the field located above the box, which defaults to <All>.

Each criteria group contains related fields you can add to the export. To view the related fields, click the plus sign next to the criteria group. For example, in an applicant export, Notes is one available criteria group. Click the plus sign next to **Notes** and several related fields appear, including **Author**, **Date Added**, and **Last Changed By**.

**Tip:** When adding fields to the **Output** box, the quickest methods are to double-click fields or to drag and drop fields from one box to the other.
To add a field to the **Output** box, select a field from the tree view in the **Available Fields** box, and click **Select**. Two quicker methods are to double-click fields or to drag and drop fields from one box to the other. When you select certain fields to export, field-specific output criteria screens appear where you can define additional characteristics records must meet to be included in the export. For more information about output criteria screens, see “Output Criteria Screens” on page 19.

**Output Tab Buttons**

**Note:** Creating an export using the Blackbaud Conditional Word Merge or Blackbaud Simple Word Merge export format adds extra buttons to the toolbar for these functions. For more information about conditional and simple merges, see “Using the Word Merge Process in Export” on page 28.

There are several buttons on the Output tab you can use to select information for an export. Use the up and down arrows to change the order of items in the **Output** box. Use the **Next** and **Back** buttons to move back and forward between the Output tab and Filters tab.

**Find.** Use the **Find** button to search for values in the tree view in the **Available Fields** box.

**Select.** Use the **Select** button to select fields to export. If you select a field that is a one-to-many group or summary, a field-specific output criteria screen appears. If you select a one-to-one field, the field is moved to the **Output** box. For more information about output fields, see “Understanding Export Output Fields” on page 15.

**Note:** When editing an export file associated with a Custom Report, the **Remove** button is disabled. You cannot delete any fields in an export used in a Custom Report.

**Remove.** Use the **Remove** button to remove selected fields from an export.

**Criteria.** Use the **Criteria** button to view criteria for a selected field. This button is enabled only when you select a one-to-many group or a summary field in the **Output** box.
**Format.** The **Format** button appears when you add the credit card, bank account, or Social Security number fields to the export file. You must have the appropriate security rights to output credit card, bank account, and Social Security numbers. If you have rights, you can click **Format** to access a screen where you can select whether the numbers should be masked or unmasked in the export file. If you do not have rights, these numbers are always masked in the export file. For more information, see the Security chapter of the *Administration Guide* for *The Education Edge*.

**Cancel.** Use the **Cancel** button to exit the Output tab or the Filters tab. The program returns to the Export page without saving changes.

**Export Now.** Use the **Export Now** button to process an export.

### Export Types

The first step in the export process is to select a record type to export. Each export can include only one export type, and the fields included in the export are only those related to that record type. For example, if you select to create an Applicant export, only fields found on applicant records are available to export. You select the export type on the Create a New Export screen.

In *Admissions Office*, you can create these export types:
- Applicant
- Faculty/Staff
- Individual
- Organization

In *Registrar’s Office*, you can create these export types:
- Class
- Course
- Faculty/Staff
- Individual
- Organization
- Student

If you have both *Admissions Office* and *Registrar’s Office* installed, you can create all of these export types from either program.
Export Formats

**Glossary:** An export format determines the way exported data appears and the software application with which it is used. Export formats include Microsoft Excel, Microsoft Access, and Lotus 1-2-3.

You must also select a format for data exported from your database. The export format determines how data appears in the data file and the application with which it is used. Export formats are especially important for exported information you plan to update in another application and then import back into *The Education Edge*. In Options, you can assign a default export format to use when creating new exports.

If you select to use the Blackbaud Simple Word Merge or Blackbaud Conditional Word Merge export format, you can use a wizard to merge information from an export file with a *Word* document template. For more information about creating merges, see “Using the Word Merge Process in Export” on page 28.

If you plan to use the export file in *Custom Reports* to create a custom Crystal report, use one of these *.mdb* formats: Blackbaud Report Writer Database, Microsoft Access 2.x Database, Microsoft Access 95 Database, Microsoft Access 97 Database, or Microsoft Access 2000 Database. For more information about using *Custom Reports*, see the Reports Guide for Admissions Office or Registrar’s Office.

You select the export format on the Create a New Export screen or on the Export Options screen. For more information about the Export Options screen, see “Export Styles” on page 9.

**Tip:** You can set a default export format in Options.

The export formats available in *Export* include:

- Blackbaud Conditional Word Merge
- Blackbaud Report Writer Database (MDB)
- Blackbaud Simple Word Merge
- Blackbaud XML Export (XML)
- Character Separated Values
- Comma-Separated Values
- dBase III
- Excel 3.0 (XLS)
- Excel 4.0 (XLS)
- Excel 5-7 (XLS)
- Excel 97-2000 (XLS)
- FoxPro Database
- Internet Document (HTML)
- Lotus 1-2-3 (WK1)
- Lotus 1-2-3 (WK3)
- Microsoft Access 2.x Database
- Microsoft Access 95 Database
- Microsoft Access 97 Database
- Microsoft ADO Recordset 2.1 (ADO)
- Microsoft ADO XML Recordset 2.1 (XML)
- Microsoft Word Merge File
- Rich Text Format\MicrosoftWord Table (RTF)
- Text
- WordPerfect Merge File
Additional Fields and Options For Export Formats

Additional fields and options appear on the Create a New Export screen depending on the export format you select.

**Note:** We recommend using column headers for exports of records you intend to update in another application and then import back into *The Education Edge*.

**Include Header.** If you select Character Separated Values, Comma-Separated Values, or Microsoft Word Merge File as the export format, the **Include Header** checkbox appears. Mark this option to include the output field names as column headers. We recommend using column headers for exports of records you intend to update in another application and then import back into *The Education Edge*.

**Separator.** If you select Character Separated Values as the export format, the **Separator** and **Qualifier** fields appear. In the **Separator** field, select the character value, such as a comma, you want to use to separate field data in the export. For example, this is a row of applicant data from a character separated data file, using commas as the separators:

Brian Thomas,Male,01/08/2004,Enrolled,248-86-7865

**Qualifier.** In the **Qualifier** field, specify the character to use, such as a quotation mark, to distinguish punctuation from character separators. For example, you have a comma that separates the city and state in an address field. Without a qualifier, the program may think the comma indicates a new field. By placing a text qualifier at the beginning and end of your field, the program knows all text contained between the text qualifiers are part of the same field. In this example, the text qualifier is quotation marks:

"Brian Thomas","In Process","643 Main St.<cr>Mt. Pleasant, SC 29464"

**Export one-to-many records.** If you select Microsoft Access 2.x Database, Microsoft Access 95 Database, or Microsoft Access 97 Database as the export format, the **Export one-to-many records** checkbox appears. To use a relational style, mark the checkbox. To use a flat style, leave the checkbox unmarked. The following section discusses relational and flat styles in greater detail.

Export Styles

**Glossary:** Export style describes how data in the data file is presented. In *The Education Edge*, there are two export styles you can use, flat style and relational style.

Export style is a term used to describe how extracted data is presented in the data file. In *The Education Edge*, there are two export styles you can use, flat style and relational style. Most export formats present only the flat style view of data, but the Blackbaud Report Writer and Blackbaud XML Export formats use only the relational style. Furthermore, for the Microsoft Access export formats, you can use the relational or flat style. For more information about export formats, see “Export Formats” on page 8.
On the Export Options screen, you can change the export format and style independently of each other, for a new or previously saved export record. You can also change the export name and description, and the VBA macro used. To access the Export Options screen, select **Tools, Export options** from the menu bar of the export record screen. For more information about using VBA macros in **Export**, see the VBA help file. To access the VBA help file, from the menu bar, select **Help, EE:VBA Help**.

![Export Options](image)

Flat Style Exports

**Glossary:** In a flat style view of data, the export displays information in grid format where each row contains a different record and each column displays a field within that record.

Most export formats support a flat style view of data. In this style, the export displays information in grid format where each row contains a different record and each column displays a field within that record. For example, in a student export, each row displays all the field information extracted for the student.

Flat style exports are used most often for creating simple **Crystal** reports. For more information about creating a flat style export, see “Creating an Export” on page 20.

**Note:** For flat style exports, you must specify the number of records to export on an output criteria screen. For more information about output criteria screens, see “Output Criteria Screens” on page 19.
There are two tools you can use to help you visualize the final output of a flattened export data file. First, select **View, Export field names** from the menu bar to view the column header name assigned by the program to each field selected for exporting. When you select this view option, the field names in the **Output** box change and become their column header name.
Once you have identified the header names, you can view a sample of your data file by selecting File, Preview Export File from the menu bar. The Preview Export File Layout screen appears displaying a grid view of the first fifteen rows of the export. Data is arranged in rows and columns as it will appear in the actual export. The column headers you viewed in the Output box are the column headers used in the grid. A field at the bottom of the screen displays the number of columns that will appear in your export.

Relational Style Exports

**Glossary:** A relational style export is an export in which the information for each selected criteria group is displayed in a separate table. Each row in the table may or may not correspond to a separate record.
A relational style export is an export in which the information for each selected criteria group is displayed in a separate table. Each row in the table may or may not correspond to a separate record. For example, if you export the student and relationship information shown below in relational style, each of the two groups appears in its own separate table rather than all in one grid as it would in a flat style export.

A relational style export of these criteria groups creates three tables: a key table to define how records are linked, a table with student information, and a table for the relationship information.

The pictures below show each of the tables as they appear when created in a Microsoft Access Database format.

**Note:** For relational style exports, specifying the number of records to export on an output criteria screen is optional. For more information about output criteria screens, see “Output Criteria Screens” on page 19.
Table 1: The Key Table — defines how records are linked

<table>
<thead>
<tr>
<th>Sts IDKEY</th>
<th>StsSt LINK</th>
<th>StsStnss 1 LNN</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>15</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>17</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>18</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>19</td>
<td>19</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>20</td>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>

Table 2: Student Information

<table>
<thead>
<tr>
<th>StsSt IDKEY</th>
<th>StsSt Students</th>
<th>StsSt SSN</th>
<th>StsSt Age</th>
<th>StsSt Current</th>
<th>StsSt LINK</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Karen Lee Stair</td>
<td>133-45-6789</td>
<td>10 (5 months)</td>
<td>05</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Theodore R Adji</td>
<td>222-20-2222</td>
<td>18 (3 months)</td>
<td>12</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Christine Lynn</td>
<td>333-65-5898</td>
<td>8 (1 month)</td>
<td>03</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>Michael John St</td>
<td>251-96-5764</td>
<td>9 (2 months)</td>
<td>01</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>Jason Ronald S</td>
<td>238-79-5451</td>
<td>17 (8 months)</td>
<td>12</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>Perry Edward Jr</td>
<td>266-69-5765</td>
<td>6 (8 months)</td>
<td>01</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>Daryl Albert Sh</td>
<td>333-46-5999</td>
<td>18 (2 months)</td>
<td>12</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>Kerry Pringle</td>
<td>126-88-8798</td>
<td>17 (3 months)</td>
<td>12</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>Sean Thomas h</td>
<td>333-65-5989</td>
<td>10 (2 months)</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>Linda Kay Quay</td>
<td>236-79-5461</td>
<td>8 (1 month)</td>
<td>12</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>Shirley Ann Rat</td>
<td>126-66-6766</td>
<td>18 (6 months)</td>
<td>12</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>Patricia Ann Sa</td>
<td>266-96-7566</td>
<td>16 (7 months)</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>Monique Karen S</td>
<td>251-90-5764</td>
<td>17 (3 months)</td>
<td>12</td>
<td>13</td>
</tr>
<tr>
<td>14</td>
<td>Janet May</td>
<td>268-89-8798</td>
<td>18 (7 months)</td>
<td>12</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>Lisa Green</td>
<td>236-79-5461</td>
<td>18 (3 months)</td>
<td>12</td>
<td>15</td>
</tr>
<tr>
<td>16</td>
<td>Cary Alice Kelly</td>
<td>126-88-6798</td>
<td>15 (10 months)</td>
<td>10</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>George Sule Na</td>
<td>266-89-5765</td>
<td>4 (4 months)</td>
<td>PK</td>
<td>17</td>
</tr>
<tr>
<td>18</td>
<td>Terry L Appleby</td>
<td>251-99-5764</td>
<td>15 (11 months)</td>
<td>10</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>Joy Perez</td>
<td>333-65-5899</td>
<td>6 (7 months)</td>
<td>01</td>
<td>19</td>
</tr>
<tr>
<td>20</td>
<td>Scott Futter</td>
<td>126-88-5785</td>
<td>16 (11 months)</td>
<td>11</td>
<td>20</td>
</tr>
<tr>
<td>21</td>
<td>Scott Renee</td>
<td>251-99-5764</td>
<td>18 (6 months)</td>
<td>11</td>
<td>21</td>
</tr>
</tbody>
</table>
You can use the relational style for these export formats: Blackbaud Report Writer, Blackbaud XML Export formats, and Microsoft Access Database formats.

Blackbaud Report Writer and the Blackbaud XML Export formats automatically use the relational style. To use the relational export style for the Access export formats, mark Export one-to-many records in separate tables on the Create a New Export screen or on the Export Options screen. To access the Export Options screen, select Tools, Export options from the menu bar of the export screen.

Understanding Export Output Fields

**Glossary:** Output fields are the fields you select to include in your export. These fields correspond to fields found in *The Education Edge.*

You have many options when deciding the type of information to export. Certain output fields have additional formatting options. You can set up multiple criteria groups for one-to-many and summary fields and specify filtering criteria for the entire group.

For example, in a student export, you can create a criteria group for conduct that is filtered to include only infractions that occurred in the current month. You can then create a second conduct criteria group filtered to include only infractions in the previous month and compare the results.

Using Criteria Groups

**Glossary:** A criteria group in Export is a set of related fields from the same record type.

Criteria groups in Export are groups of related fields from the same record type. For example, the Applicant criteria group contains only fields found in an applicant record.

The Output tab of an export record displays all the criteria groups in the Available Fields box. There are three types of criteria groups: one-to-one groups, one-to-many groups, and summary groups. The terms one-to-one, one-to-many, and summary illustrate the relationships between fields within criteria groups.
One-to-One Criteria Groups

Glossary: A one-to-one criteria group is composed of fields for which only one value exists in your database.

A one-to-one criteria group is composed of fields for which only one value exists in your database. For example, in an applicant export, the Applicant group contains fields such as Current grade, Inquiry date, and Current status. This group qualifies as a one-to-one criteria group because each of these fields can have only one assigned value on an applicant record.

You can identify one-to-one criteria groups in two ways. First, in the Available Fields box, each one-to-one criteria group is designated by an icon depicting a single table. Second, when you select an output field from a one-to-one criteria group, the Criteria button is disabled and you cannot assign any additional criteria to the group.

One-to-Many Criteria Groups

Glossary: A one-to-many criteria group is composed of fields for which several values exist in your database.

A one-to-many criteria group is composed of fields for which several values exist in your database. For example, in an applicant export, Activities is a one-to-many criteria group because each applicant can be associated with more than one activity. You can identify one-to-many criteria groups in two ways. First, in the Available Fields box, each one-to-many criteria group is designated by an icon depicting multiple tables.

Second, when you select an output field from a one-to-many criteria group, an output criteria screen appears with additional filtering options specific to that criteria group. For more information about criteria options, see “Output Criteria Screens” on page 19.
Summary Criteria Groups

Glossary: A summary criteria group is composed of fields of calculated data rather than field information that is available directly from the database.

A summary criteria group is composed of fields of calculated data rather than field information that is available directly from the database. For example, in a student export, there is a summary criteria group for attendance information by class. The Summary criteria group contains fields for the number of absences for each student, total number of absences for the class, and the number of tardies.

In the Available Fields box, each summary criteria group is labeled “Summary”. When you select an output field from a summary group with a multiple tables icon, an output criteria screen appears with additional filtering options specific to that criteria group. For more information about output criteria screens, see “Output Criteria Screens” on page 19.

Using Multiple Criteria Groups of the Same Type

In Export, you can define multiple criteria groups for one-to-many and summary fields. This means that you can define multiple instances of the same group type, each with its own unique filtering criteria. This feature is useful for comparing similar items. For example, to compare PSAT and SAT scores for seniors, you can create an export with two Test criteria groups — one for PSAT and one for SAT. This results in an export where one column lists student PSAT scores and one column lists SAT scores. The following procedure demonstrates how to set up this export.
Creating multiple criteria groups of the same type

1. From an open student export, in the Available Fields box, expand the Tests criteria group.

2. Select the Score field in the Tests group. The Tests output criteria screen appears. For more information about output criteria screens, see “Output Criteria Screens” on page 19.

3. In the For each Student, enter the number of Tests to export field, enter “1”. For more information about using the number to export field, see “Output Criteria Screens” on page 19.

4. Mark Selected Tests and select “PSAT”. “PSAT” moves to the selection box.
5. Click **OK**. The Tests group now appears in the **Output** box.

![New Student Export](image)

6. For the second criteria group, in the **Available Fields** box, select the **Score** field again. A screen appears to notify you that this field already appears in a group and asks if you want to add a new group.

7. Click **Yes**. The Tests output criteria screen appears.

8. In the **For each Student, enter the number of Tests to export** field, enter “1”.

9. Mark **Selected Tests** and select “SAT”. “SAT” moves to the selection box.

10. Click **OK**. The Tests 2 group now appears in the **Output** box.

![New Student Export](image)

11. Continue adding fields or click **Export Now** to run the export.

**Output Criteria Screens**

**Note:** You can also use the **Criteria** button in the Output box to access an output criteria screen for one-to-many or certain summary criteria groups.

In an export record, when you select to export fields from one-to-many or certain summary criteria groups, an output criteria screen appears. On this screen, you can define additional characteristics records must meet to be included in the export.
The type of criteria screen that appears depends on the field you select. For example, in a student export, if you select a field in the Activities criteria group, the Activities criteria screen appears. On this screen you can select the number of activities to export for each student, define a date range of activities to include, and set the sort order of the export results. On the Filters tab, you can filter by activity categories and activity descriptions. Selections made on the Filters tab apply to only the items in the criteria group, not the entire export. Not all output criteria screens have a Filters tab.

Multiple criteria screens appear when you select certain export fields. For example, in student and applicant exports, if you select a field in the Recommendations criteria group (found in the Education criteria group), two criteria screens appear — one for specifying how to export the education records and one for specifying how to export the recommendation records.

![Activities Criteria Screen]

It is important to use the correct number in the number to export field. For example, you can create an applicant export including education information and recommendations from schools an applicant attended previously. On the criteria screen for the education information, in the number to export field enter the highest number of schools the applicant attended. For example, if the applicant attended two schools, enter 2. On the criteria screen for recommendations, in the number to export field enter the number of recommendations your school requires. For example, if your school requires recommendations from a math teacher, an English teacher, and a character recommendation, enter 3 in the number to export field. This export produces information about the three recommendations received from both of the schools the applicant attended.

Creating an Export

Using Export, you can extract records from your database to use in other applications. For example, once you export a file of records, you can edit it in Excel, and then import the file back into The Education Edge to update the database. The appearance of export data files may differ depending on the export format and style you select to use. You can use a control report to view or print information about the data included in the export. The following procedure guides you through creating an applicant export in Excel format.
Creating an export

1. From the Export page, click New. The Create a New Export screen appears.

![Create a New Export](image)

Note: On the Export Options screen, you can change the export format and export style independently of each other at any time. For more information about the Export Options screen, see “Export Styles” on page 9.

2. Select the export type and the export format. For this example, we create an applicant export in Excel format. For more information about export formats, see “Export Formats” on page 8.
   
   If you select “Comma-Separated Values”, “Character Separated Values”, or “Microsoft Word Merge File” as the export format, the Include Header checkbox appears. Mark this option to add column headers for the fields included in the export.

Note: We recommend using column headers for exports of records you intend to update in another application and then import back into The Education Edge.

3. Click Create Now. The New Applicant Export screen appears displaying the Filters tab.

![New Applicant Export](image)
4. Select criteria to determine which records to include in an export. For this example we filter by selected applicants. For more information about filtering, see the *Program Basics Guide*.

![](image1.png)

5. Click **Next** or select the Output tab.

![](image2.png)

6. In the **Available Fields** box, a tree view lists all the criteria groups available for the export type you are creating. Click the plus sign next to a criteria group to view all of the fields available for that criteria group. For more information about criteria groups, see “Using Criteria Groups” on page 15.
For this example, we expand the Applicant criteria group.

7. To add fields from the tree view to the Output box, select the field and click Select. The field moves to the Output box. For this example, we add the Applicant name field.

8. Continue until you have added all the fields you need for that criteria group.

   You must have the appropriate security rights to output credit card, bank account, and Social Security numbers. If you have rights, when you add these fields to the export file, the Format button appears next to the Criteria button on the Output tab. When you click Format, a screen appears where you can select whether the numbers should be masked or unmasked in the export file. If you do not have rights, these numbers are always masked in the export file. For more information, see the Security chapter of the Administration Guide for The Education Edge.
9. Expand the next criteria group with fields you want to export. For this applicant export, we expand the Applications criteria group.

10. Select a field from the criteria group to add to the Output box. For this example, we select the Application date field. The Applications output criteria screen appears.

**Tip:** In Options, you can set default values to export for yes/no fields.

11. On the General tab of the output criteria screen, enter a number in the number to export field.

**Glossary:** A one-to-many criteria group is composed of fields for which several values exist in your database. For more information about one-to-many criteria groups, see “One-to-Many Criteria Groups” on page 16.

Because Applications is a one-to-many criteria group, when you select a field from the group, an output criteria screen appears. On output criteria screens, you define additional characteristics records must meet to be included in the export and determine the number of items to export per record type. Criteria set on the Applications output criteria screen applies to all fields added to Applications criteria group. For more information about output criteria screens, see “Output Criteria Screens” on page 19.

**Warning:** When using multiple criteria groups of the same type, to ensure that each column of exported information contains only one type of data, it is important to use the correct number in the number to export field. For more information, see “Using Multiple Criteria Groups of the Same Type” on page 17.
For this example, we enter “1” in the For each Applicant, enter the number of Applications to export field. For more information about using the number to export field, see “Output Criteria Screens” on page 19.

12. In the Include these dates frame, enter dates in the Date from and Date to fields.
13. Select an item to sort by in the Order by field, and mark Ascending or Descending for the sort order.

Note: Selections made on the Filters tab apply to only the items in the criteria group, not the entire export. Not all output criteria screens have a Filters tab.

14. Select the Filters tab of the output criteria screen. On this tab, you can define additional criteria for the items in the group. For this example, we do not select any additional filters.

15. Click OK and you return to the Output tab. The Application date field appears in the Output box.
16. Continue adding fields until you have added all the fields you need for the Applications criteria group.

17. To print or preview a control report listing the selected criteria groups, output fields, and field header names for the export, mark Create control report and mark Print or Preview. The control report prints or previews after the export processes.

18. To preview a sample of your data file, select File, Preview Export File from the menu bar. The Preview Export File Layout screen appears displaying a grid view of the export.

19. Click Close to exit the preview screen. You return to the Output tab.

**Tip:** In Options, on the File Locations tab, you can define default file locations for export files.

20. Click Export Now to run the export. The Export file name screen appears.

21. Browse to the location where you want to save the exported data file and enter a file name in the File name field.
Tip: In Options, you can set the program to save export records automatically.

22. Click **Save**. You return to the export record and processing screens appear. When the export finishes, a screen appears telling you the number of rows exported and the time elapsed.

23. Click **OK**. If you selected to preview a control report, the control report screen appears.

24. Click **X** to exit and return to the export record.

25. Click **Save and Close**. The Save Export As screen appears.

26. Enter a name and description for the export record and mark if other users can run or modify this export.

27. Click **Save**. You return to the Export page.

### Running an Export from the Export Page

You can use saved export records as templates for exports you run frequently. For example, if you use an *Excel* spreadsheet to track conduct each month, you can create a student export including conduct activity. At the end of each month, you can run the saved student export to update the spreadsheet with the specified conduct information.

To save time, you can run an export directly from the Export page without having to open the export record. This function makes it quick and easy to update an export data file to include new data entered into the database since the last time you ran the export. You can also designate an export as a favorite and add it to your home page. For more information about favorites, see the *Program Basics Guide*. 
Running an export from the Export page

1. From the Export page, select the export to run and click Export. The Export file name screen appears.

2. The export’s data file name appears in the File name field. You can either overwrite the existing data file or save the updated data file as a new record.
   - To overwrite the existing data file with the updated data file, click Save. A message screen appears asking if you want to replace the existing file. Click Yes.
   - To save the updated data file as a new record, enter a new name in the File name field and click Save.

3. A processing screen appears. Once the export finishes processing, a message appears indicating the number of rows exported and the elapsed time. Click OK and return to the Export page.

Using the Word Merge Process in Export

Warning: You must have Word 2000 or Word XP installed on your computer to create Word document merges in Education Edge.

Export is integrated with Microsoft Word features so you can use information exported from your Education Edge database to create custom documents such as form letters, mailing labels, envelopes, and mass email and fax distributions directly from Export.

The merge process consists of merging a document template, such as a form letter, with variable information exported from The Education Edge. This process produces documents with the same basic format and text, yet each individual document is customized with specific Education Edge information.

You can create two types of Word merges, simple and conditional:

- Simple merges produce a series of documents using the same document template, customized with information exported from The Education Edge.
- Conditional merges create a series of documents using multiple text formats, customized with fields of information exported from The Education Edge, which differ based on specified conditions.

The procedures in this section guide you through creating simple and conditional merges in Export.
Creating a Simple Word Merge

Use the simple merge process to merge an export file with a single document template to produce a group of documents customized with fields of information exported from The Education Edge. For example, you can create a form letter to send to all students with information about fall registration. The body of the letter is the same for all students, but the address section is customized with the recipient’s name, address, and student ID.

Overview of the Process

This is an overview of the process you would use to create the letters described in the previous example:

**Tip:** While you can create the document template directly from Export after selecting the fields to export, we recommend creating the document in Word first and later inserting it. This makes it easier to identify which fields you need to export.

**Step 1.** In Word, create the document template for the letter, leaving placeholders where you want to later include data.

**Step 2.** In Export, set up the export using the Blackbaud Simple Word Merge format. Include fields for the student’s name, ID, and address information.

**Step 3.** Click Edit merge file on the toolbar to access Word. Insert the document template you created in step 1 into the blank Word document.

**Step 4.** Insert the field names you included in the export file into the placeholders created for that information. For example, if you created a placeholder for the student name, insert the Student name field.

**Step 5.** Return to the export record and run the merge. A Word file containing the merged documents is saved in the location you designate. You can preview these documents and make necessary changes before saving the export record.

Creating a simple merge in Export

1. Once you complete the planning of your documents, open Word.

2. Create the document template by typing the document in Word, leaving placeholders for the fields of information to add later. For example, for this letter we create a header with the student’s address information. We leave placeholders for the student’s name, ID, and each address field.

   <Student’s name>
   <Student ID>
   <Address>
   <City>, <State> <Zip>
We also include fields for the student’s first name, the financial aid type, the amount awarded, and the date awarded.

We enclose the field name in brackets < > to designate a placeholder. These placeholders help identify where Education Edge information should be inserted.

3. When you finish, save the document template in a location you can easily access again.


5. Click New. The Create a New Export screen appears.

6. In the What type of export do you want to create? box, select “Student”.

Tip: You can set a default export format in Options. For more information about export options, see the Options chapter of the Program Basics Guide.

7. In the Export format field, select “Blackbaud Simple Word Merge”.

8. Click Create Now. The New Student Export record screen appears displaying the Filters tab.
9. Select criteria to determine which records to include in an export. For this example we filter to include only enrolled students. For more information about filtering, see the Program Basics Guide.

10. Click Next or select the Output tab. The Output tab appears.

11. In the Available Fields box, a tree view lists all the criteria groups available for students. Click the plus sign next to a criteria group to view all fields available for that criteria group. For more information about criteria groups, see “Using Criteria Groups” on page 15.
For this example, we expand the Student criteria group.

12. To add fields from the tree view to the Output box, select a field and click Select. The field moves to the Output box.

For this example, we add the Student name and Student ID fields. The Student name and Student ID fields appear in the Output box.

Tip: When adding fields to the Output box, the quickest methods are to double-click fields, or to drag and drop fields from one box to the other.

13. Expand the next criteria group with fields you want to export. Continue until you have added all the fields necessary to export.

Note: If you select a one-to-many field, enter “1” as the number to export on the output criteria screen. For more information about one-to-many criteria groups, see “One-to-Many Criteria Groups” on page 16.
For this student export, we expand the Addresses criteria group and select the **Address, City, State/Province** and **Zip/Postcode** fields. Because Addresses is a one-to-many field, an output criteria screen appears. Enter “1” in the number to export field. For more information, see “One-to-Many Criteria Groups” on page 16.

14. On the toolbar, click **Edit word merge file**. **Word** opens automatically to a blank document to use to create your template document.
15. You already created the text for the document template in steps 1 through 3 — now you need to insert it into this blank document. From the file menu, select **Insert**, **File**. The Insert File screen appears.

![Insert File Screen]

16. Browse to the location where you saved the document template. Select the **Word** *.doc* file and click **Insert**. The text for the document template appears in the new **Word** document.

![Word Document Screen]

January 15th, 2004

<Student’s name>
<Student ID>
<Address>
<City>, <State> <Zip>

Registration for the 2004/2005 school year begins next week, January 31st. 30th for rising sophomores, juniors, and seniors. In your class meetings on January 20th, you will receive a packet of information containing your transcript as of the end of first semester this year, a teaching schedule showing classes, teachers, and periods for next fall, and a schedule request form that must be completed prior to registration. The registration packets will be explained in detail during your class meeting.

If you have any questions, please call the admissions office at 864-8966.
17. Highlight the placeholder for which you want to insert the first field of information. For this example, we highlight the <Student’s name> placeholder in the header so we can insert the Student name field in its place.

18. Once the placeholder is highlighted, click Insert Education Edge field on the toolbar. A list of the exported fields appears.
19. Select the first field you need from the list. For this example, we select the Student name field. The program field name for Student name appears in the document replacing the <Student’s name> placeholder.

![Image of the New Student Export screen]

January 15th, 2004

Registration for the 2004/2005 school year begins next week, January 28th-30th for rising sophomores, juniors, and seniors. In your class meetings on January 29th, you will receive a packet of information containing your transcript as of the end of first semester this year, a teaching schedule showing classes, teachers, and periods for next fall, and a schedule request form that must be completed prior to registration. The registration packets will be explained in detail during your class meeting.

If you have any questions, please call the admissions office at 864-8966.

20. Repeat these steps to continue placing the fields in the appropriate placeholders. For this example, we also add the Student ID, Address, City, State/Province and Zip/Postcode fields.

![Image of the New Student Export screen]

January 15th, 2004

Registration for the 2004/2005 school year begins next week, January 28th-30th for rising sophomores, juniors, and seniors. In your class meetings on January 29th, you will receive a packet of information containing your transcript as of the end of first semester this year, a teaching schedule showing classes, teachers, and periods for next fall, and a schedule request form that must be completed prior to registration. The registration packets will be explained in detail during your class meeting.

If you have any questions, please call the admissions office at 864-8966.

21. To return to Export to continue the merge process, click Save and return to EE7 to Merge. You return to the New Student Export screen.
22. To run the merge, click **Merge Now**. The Export file name screen appears.

![Export file name screen](image)

You can save the merged documents in the default location or browse to a folder in a different location using the **Save in** field.

23. In the **File name** field, enter a name for the merged documents.

24. The **Save as type** field defaults to “Blackbaud Simple Word Merge”. Leave the data type as “Blackbaud Simple Word Merge”. This saves the merged documents as a *.doc file you can open in **Word**.

25. Click **Save** and a processing screen appears. Once the export is complete, a screen appears displaying the number of rows exported.

26. Click **OK** to return to the export record.

27. Before saving, you can view the merge documents and make changes to the **Word** document or to the exported data.

   - To view the merged documents, open **Word** and then open the saved *.doc file. (You can find the *.doc file on the **File** menu list of recently saved documents.)

   - The **Word** document opens to the first page of the merged document. This single **Word** document contains all of the merged documents created from the export, each appearing on a separate page. Student-specific information now appears in each place you inserted a field name.
• To view the other documents created, scroll down to view the next page.

28. You can edit the document directly in Word. When finished, save and close the document, exit Word, and return to your export record.

29. To save the export record, click Save and Close on the toolbar. The Save Export As screen appears.

30. Enter a name and description for the export. To give others rights to run or modify this export record, mark Others can run this export and Others can modify this export.

31. Click Save. The export record is saved and appears in the list on the Export page.

Creating a Conditional Word Merge

The conditional merge process is essentially the same process as a simple merge in that both use Microsoft Word integrated features to produce documents customized with information exported from your Education Edge database. However, with the conditional merge, you can create more complex merges that use multiple document templates rather than a single document template. Furthermore, you can define conditional “If/Then” statements that determine which document a recipient should receive.

For example, you can create form letters to notify applicants they were accepted, denied, or waitlisted. You can create an export file of all individual applicants, and using the conditional merge process, define conditional statements that match applicants with the letter they should receive based on their current applicant status. Furthermore, each letter is customized with information specific to its recipient, such as his or her name and address.

Overview of the Process

This is an overview of the process you would use to create the applicant letters described in the previous example:

Tip: While you can create the document template directly from Export after selecting the fields to export, we recommend creating the document in Word first and later inserting it. This makes it easier to identify which fields you need to export.

Step 1. In Word, create three unique letters, one letter for accepted applicants, one letter for denied applicants, and one letter for waitlisted applicants. Leave placeholders for exported information.
Step 2. In Export, create an export file including applicants with an applied, denied, or waitlisted current applicant status. Include fields for the applicant’s name, address information, and applicant status.

Step 3. Using the Conditional Word Merge Wizard, select the export field to use as the condition and define conditional statements to match recipients with the letter they should receive based on their applicant status. For this example, one conditional statement would be, “Use this document when Current Status is equal to Accepted”.

Step 4. Click Edit merge document to access Word. Insert the letter created for the first condition into the blank Word document.

Step 5. Insert the field names you selected in the export into the placeholders created for that information. For example, if you left a placeholder for the applicant’s name, insert the **Applicant name** field here.

Step 6. Repeat steps 4 and 5 for the other two letters.

Step 7. Run the merge. A Word file containing the merged documents is saved in the location you designate. You can preview these documents and make any necessary changes before saving the export record. For information about editing conditional merge documents, see “Editing Conditional Word Merge Documents” on page 50.

Creating a conditional merge in Export

1. Once you complete the planning of your documents, open Word.

2. Create the first document template by typing the document in Word, leaving placeholders for the fields of information you will add. For example, we create the first letter for accepted applicants. The letter begins with a header with the applicant’s address and a salutation. We leave placeholders for the applicant’s name and each address field.

   <Applicant’s name>

   <Address>

   <City>, <State> <Zip>

   Dear <First name>,

   We enclose the field name in brackets <> to designate a placeholder. These placeholders help identify where exported information should be inserted.

3. When you finish, save the document template in a location you can easily access again.

4. Repeat steps 2 and 3 for the other conditions in this series of documents. For this example, we also create document templates for waitlisted and denied applicants.
5. Open *Admissions Office*. On the navigation bar, click Export. The Export page appears.

6. Click New. The Create a New Export screen appears.

![Create a New Export](image)

**Tip:** You can set a default export format in Options. For more information about user options, see the *Program Basics Guide*.

7. In the **What type of export do you want to create?** box, select “Applicant”.

8. In the **Export format** field, select “Blackbaud Conditional Word Merge”.

9. Click **Create Now**. The New Applicant Export screen appears displaying the Filters tab.

10. Select criteria to determine which records to include in the export. For this example, we filter by Applicant Current Statuses so the export includes only applicants with a status of accepted-not enrolled, waitlisted, or denied. For more information about filtering records, see the *Program Basics Guide*.

![New Applicant Export](image)
11. Click **Next** or select the Output tab. The Output tab appears.

![New Applicant Export]

12. In the **Available Fields** box, a tree view lists all the criteria groups available for applicants. Click the plus sign next to a criteria group to view all of the fields available for that criteria group. For more information about criteria groups, see “Using Criteria Groups” on page 15.

For this example, we expand the Applicant criteria group.

![New Applicant Export]

**Tip:** When adding fields to the **Output** box, the quickest methods are to double-click fields, or to drag and drop fields from one box to the other.

13. To add fields from the tree view to the **Output** box, select a field and click **Select**. The field moves to the **Output** box.
For this example, we add the Applicant name, First name, and Current status fields from the Applicant criteria group. These fields move to the Output box.

Note: If any of the fields you select is a one-to-many field, enter “1” as the number to export on the output criteria screen. For more information about one-to-many criteria groups, see “One-to-Many Criteria Groups” on page 16.

14. Expand the next criteria group containing fields you want to export. Continue until you have added all the fields necessary to export. For this applicant export, we expand the Addresses criteria group and select the Address, City, State/Province, and ZIP/Postal code fields.

16. Select the export field from the tree view to use as the condition for the documents. For this example, we select the **Current status** field found in the Applicant group.

17. Click **Next**. The Blackbaud Conditional Word Merge Wizard — Step 2 screen appears.

![Conditional Merge Document](image)

19. In the **Condition** field, select “equal to”.

20. In the **this value** field, enter the first field value to use as a condition. In this example, we enter “Accepted - Not Enrolled”. This will match accepted applicants with the acceptance letter.

21. In the **Document description** field, enter a name for the document. For this example, we name the document “Acceptance Letter”.

![Conditional Merge Document](image)

22. Click **Edit merge document**. *Word* opens to a blank document titled “Merge document for condition ‘equal to Accepted’”.

![Merge document](image)
23. You already created the text for the document template in steps 1 through 3 — now you need to insert it into this blank document. From the menu bar, select **Insert, File**. The Insert File screen appears.

24. Browse to the location where you saved the document template for the first condition. Select the **Word *.doc** file and click **Insert**. The text for the document template appears in the **Word** document.
25. Highlight the placeholder for which you want to insert the first field of information. For this example, we highlight the <Applicant Name> placeholder in the header so we can insert the Applicant Name field in its place.

26. Once the placeholder is highlighted, click Insert Education Edge field on the toolbar. A list of the exported fields appears.
27. Select the first field you need from the list. For this example, we select the **Applicant name** field. The program field name for Applicant name appears in the letter replacing the <Applicant’s name> placeholder.

28. Repeat these steps to continue placing fields in the appropriate placeholders. For this example, we also add the **Address**, **City**, **State/Province**, **ZIP/Postal code**, and **First name** fields.

29. To return to Export to continue the merge process, click **Save and return to EE7 to Merge**. You return to the Conditional Merge Document screen.
30. Click **OK**. You return to the Blackbaud Conditional Word Merge Wizard — Step 2 screen and the new condition appears in the grid.

31. Click **New Document**. The Conditional Merge Document screen appears. Repeat steps 19 through 30 until you have created a document for each condition.

32. Once you have added program fields to each document template, click **Finish**. You return to the New Applicant Export screen.

33. Click **Merge Now** to run the merge. The Export file name screen appears.

   ![Export file name screenshot]

   You can save the merged documents in the default location, or you can browse to a folder in a different location using the **Save in** field.

34. The conditional merge process produces a file folder that contains several files including the merged documents file. In the **File name** field, enter a name to use for both the file folder and the merged documents file. For this example, we enter “Applicant Letters”.

35. The **Save as type** field defaults to the “Blackbaud Conditional Word Merge”. Leave the data type as “Blackbaud Conditional Word Merge”. This saves the merged documents as a *.doc file you can open in Word.

36. Click **Save** and a processing screen appears. Once the export is complete, a screen appears displaying the number of rows exported.

37. Click **OK** to return to the export record.
38. You can view the merged documents and make any necessary changes to the Word document or to the exported data before saving the export record. To view the documents, open the file folder you just created.

The folder generated by the merge process contains several files — *.doc files for each condition you created (named Condition_#); an *.html file named DATA that lists all the exported information included in the documents; the MERGE.doc file; and the *.doc file with the same name as the folder.

39. Open the *.doc file with the same name as the folder — in this example, Applicant Letters. This *.doc file contains all of the merged documents created from the export, each appearing on a separate page.

The Word document opens to the first of the generated documents. Applicant-specific information now appears in each place you inserted a field name.

To view the other documents created, scroll down the screen to view the next page.

40. If you need to make changes to documents, you have two options:
   - If you need to make minor changes to only a few documents you can make those directly to the documents in Word.
• If you need to make the same changes to several letters, it is better to make those changes directly to the document template using the Conditional merge wizard. For detailed instructions, see “Editing Conditional Word Merge Documents” on page 50.

41. When finished making changes, save and close the document, exit Word, and return to the export record.
   To save the export record, click **Save and Close** on the toolbar. The Save Export As screen appears.

42. Enter a name and description for the export. To give others rights to run or modify this export record, mark **Others can run this export** and **Others can modify this export**.

43. Click **Save**. The export record is saved and appears in the list on the Export page.

**Editing Conditional Word Merge Documents**

After you run a conditional merge, you can make changes or updates as needed. If you find you need to make changes to multiple documents, you can make these changes directly to the document templates using the Conditional merge wizard.

- **Editing conditional Word merge documents**
  1. From the open *.doc file of merged documents, identify the changes that need to be made.
  2. Close the *.doc file and return to the export record.
  3. On the Output tab, click **Conditional merge wizard**. The Blackbaud Conditional Word Merge Wizard — Step 1 screen appears.
4. Click **Next**. The Blackbaud Conditional Word Merge Wizard — Step 2 screen appears.

![Blackbaud Conditional Word Merge Wizard](image)

5. In the grid, select the document you need to edit, and click **Open**. The Conditional Merge Document screen appears.

![Conditional Merge Document](image)

6. Click **Edit merge document**. *Word* opens the saved merge document you selected.

![Word Document](image)

7. You can edit the text of the document, fix punctuation, run the Spelling and Grammar check, and insert additional data fields.

8. When you finish making changes, click **Save and return to EE7 to merge**. You return to the Conditional Merge Document screen.
9. Click **OK**. You return to the Blackbaud Conditional Word Merge Wizard — Step 2 screen. From this screen you can select another document to edit and repeat steps 5 through 9.

10. When you finish editing, click **Finish**. You return to the Output tab.

11. Click **Merge Now** to run the merge again and update the documents with the changes. The Export file name screen appears.

12. Without making changes to the file name, type, or location, click **Save**. This will replace the original merge documents with the edited versions.

   Once the export is complete, a screen appears displaying the number of rows exported.

13. Click **OK** to return to the export record.

14. You can now open the *.doc file to view the updated documents and make sure all the necessary changes were made.
Index

A
accessing export records 2

C
conditional word merge 38, 39
creating
conditional word merges 39
exports 21
multiple criteria groups of the same type 18
simple word merges 29
criteria group
creating multiples of the same type 18
multiples of same type 17
one-to-many 16
one-to-one 16
overview 15
summary 17

E
export
creating 21
formats 8
output fields 15
running from the Export page 27, 28
export output field 15
export record
conditional word merges 38
criteria groups
multiples of same type 17
one-to-many 16
one-to-one 16
overview 15
summary 17
finding and opening 3
output criteria screens 19
simple word merges 29
tabs
filters 4
output 5
export style
flat 10
overview 9
relational 12
export type 7
exporting, overview 2

F
filters tab 4
finding export records 3
flat style export 10
format, export 8

M
multiple criteria groups 17, 18

O
one-to-many criteria group 16
one-to-one criteria group 16
opening export records 3
output criteria screen 19
output tab 5

R
relational style export 12
running exports from the Export page 27, 28

S
simple word merge, creating 29
style, export 9
summary criteria group 17

W
word merge
conditional 38
creating simple merges 29
simple 29